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Notice
VICORE Installation Manual
Document Number 405-00084-00

Copyright 2021 Teledyne Imaging.
All rights reserved.

All copyrights in this manual, and the hardware and software described in it, are the 
exclusive property of Teledyne Imaging and its licensors.
Claim of copyright does not imply waiver of Teledyne Imaging or its licensors other 
rights in the work. See the following Notice of Proprietary Rights.

NOTICE OF PROPRIETARY RIGHTS
This manual and the related hardware and software are confidential trade secrets 
and the property of Teledyne Imaging and its licensors. Use, examination, 
reproduction, copying, transfer and/or disclosure to others of all or any part of this 
manual and the related documentation are prohibited except with the express 
written consent of Teledyne Imaging.

The information in this document is subject to change without notice. Teledyne 
Imaging makes no representations or warranties with respect to the contents of this 
manual and specifically disclaims any implied warranties of merchantability or 
fitness for a particular purpose. Teledyne Imaging assumes no responsibility for 
errors or omissions in this document.

iNspect, Sherlock, and the Teledyne Imaging logo are trademarks of Teledyne 
Imaging. All other trademarks are the property of their respective owners.

Teledyne Digital Imaging US, Inc.
Information: TDI_Sales.ipd@teledyne.com
Support: TDI_Support.ipd@teledyne.com

Web: http://www.teledynedalsa.com/visionsystems

700 Technology Park Drive
Billerica, MA, USA 01821

Tel 1.978.670.2002 Fax 1.978.670.2010
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Certifications

Declaration of Conformity

Manufacturer Teledyne Digital Imaging US, Inc.
700 Technology Park Drive
Billerica MA 01821
USA

CE We declare that this product has been tested to comply with the 
EC Directive for a class A digital device in accordance with 
EN55022/CISPR22

FCC We declare that this product has been tested and found to 
comply with the limits for a class A digital device, pursuant to 
Part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation. 
This equipment generates, uses and can radiate radio 
frequency energy and may cause harmful interference to radio 
communication. 

Other

CFR 21 Part 11 This product provides tools needed for users to implement an 
auditing program that could be in compliance with CFR 21 Part 
11. These tools include:
• System or software backup and restore
• System software security (password login and access limits)   
• Protection of system backup files from modification. 
• Record of actions by users with time stamp information 
• Time stamp information on data output. 
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Electrostatic Discharge
Avoid the damage that ESD can cause. Never expose the internal electronics to a 
potentially hazardous environment by opening the enclosure. Doing so may cause 
serious damage.

User Service Warning
This product has no field-replaceable components. Tampering with the unit will void the 
product warranty.

Warranty
Teledyne Imaging warrants the VICORE System against defects in materials and 
workmanship for a period of Twelve (12) months from the date of delivery. Teledyne 
Imaging and its representatives expressly disclaim any and all other warranties. 

Your sole remedy shall be repair or replacement of the VICORE System product and 
associated optional components, provided that the defective product is returned within 
the warranty period.

If you need to return the VICORE System, you must contact the Teledyne Imaging 
representative who sold you the product. Do not return your product to Teledyne Digital 
Imaging US without prior authorization.

Teledyne Imaging assumes no liability for damages resulting from the use of this 
manual.

Handling Precautions
Care should always be exercised when handling and operating your VICORE System. 
Even though the system is encased within a rugged, industrial enclosure, incorrect use 
or handling can result in damage to your investment. To prevent this, we recommend 
the following precautions:
• Avoid “hot-plugging” cables and devices. Be sure to shut the system down and 

remove power before connecting or disconnecting anything to it.

• Do not use in a Free-standing operation. Mount the system properly to prevent it from 
falling accidentally. Mounting hardware is provided with the system. 

• Always use the VICORE system within the recommended operating conditions. Refer 
to the complete specifications on page 13.

• Do not install the VICORE system in a location that will expose it to excessive heat, 
humidity, vibration, impact, corrosive substances, or flammable substances.

• Do not attempt to service or modify the VICORE system by opening the enclosure. 
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Introduction

The VICORE (Vision Core Element) system is a compact dual-camera vision system 
that supports image acquisition, processing, display and communications. VICORE 
uses industrial grade components encased within a fan-less aluminum enclosure. It is 
offered with panel mountable hardware. 

The VICORE system has a small footprint that requires minimal cabinet space. All 
camera, I/O and network connections are conveniently accessed from the front, serial 
port and encoder inputs on the top, and power on the bottom to simplify wiring. 

The VICORE system is equipped with 2 Ethernet ports for interfacing GigE cameras, 1 
Ethernet LAN port for general communication with network devices and 1 dedicated 
industrial networking port for interfacing with devices that support either Ethernet/IP or 
Profinet. This dedicated port cannot be used for other PLC protocols, cameras or other 
network connections. 

The VICORE system has 8 General Purpose inputs and 8 General Purpose outputs 
plus dedicated shaft encoder inputs for synchronizing control outputs to the speed of 
the conveyor.

VICORE Vision System Overview

Product Support
This manual will assist you with the installation and setup of your VICORE product and 
the embedded inspection software. It describes what the product supports and how to 
connect the external interfaces. If your questions are not answered in this reference, 
please contact your local Teledyne Imaging representative.
Additional manuals are available on the VICORE system disk at: 

C:\IPD Install Files\PDF Manuals

Additional files for use in your PLC Programming environment are located on the 
VICORE system disk at: C:\IPD Install Files\PLC Support Files.  
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VICORE vision systems are shipped with the components listed below. Take a few 
moments to verify that everything has arrived in good condition. If your product has 
been visibly damaged during shipment or is missing parts, please contact your Teledyne 
Imaging representative immediately. 

VICORE Vision System Components

Component Description

VICORE Vision System
xxxxxxx-03 or
xxxxxxx-04

Fully integrated vision system with iNspect Express (-03) or 
Sherlock (-04) embedded software, power connector, and 
panel mounting hardware.

Component Description

A-CAM-GX-XXXX Genie Nano Series GigE cameras.

A-CAB-GE-X GigE CAT5e camera cables (video data, network communication).

A-CAB-G3-IO-X Genie Nano IO/Trigger/Strobe

A-CAB-G2-TPS-X Genie TS IO/Trigger/Strobe

A-CAB-GTP-X Genie classic Trigger/Strobe

Optional components (sold separately): 

Standard components (ship with every VICORE Vision System): 
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Installation

This section details the physical connections on the VICORE vision system. The 
VICORE provides connectors on the front, left and right plates.  

Connecting the VICORE Vision System
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1 2 4

7

Front Connections

6

3

1. Status LEDs, power, reset, fault, and 3 application-programmable.
2. Two USB 2.0 ports, Two USB 3.0 ports.
3. HDMI video output up to 2560x1600 resolution @ 60 Hz, (larger at lower refresh rate).

4. GigE Port for LAN, TCP/IP, UDP/IP, or Modbus. Default static IP: 192.168.0.100. 
This port does not support Profinet or Ethernet-IP.

5. Status LEDs for inputs and outputs.
6. Two POE GigE Camera ports. Static IP: CAM1 192.168.11.1, CAM2 192.168.12.1.
7. Camera IO: 1 input and 1 output per camera, 4 Status LEDs
8. 100MBps Port for Ethernet-IP or Profinet only. Default setting: Ethernet-IP, static IP 

address 192.168.10.100. This port is not available in Windows adapter settings. 
This port cannot be used for other network or camera connections.

9. General Purpose IO: 8 inputs, 8 outputs.

8 9

Note: Camera Ethernet cables must be type Cat5e. Use A-CAB-GE-X.

LAN left LED: Off = 10 Mbits/s; GREEN = 100 Mbits/s; ORANGE = 1000 Mbits/s.
LAN right LED: ON = port active; BLINK = port traffic.

5



NOTES:

1. Cameras are powered by POE (Power Over Ethernet).

2. Use A-CAB-GE-X for camera Ethernet connections.

3. Use A-CAB-G3-IO-X for the Genie Nano I/O Connector to VICORE Camera IO Connector. 
Provides support for 1 input and 1 output each camera, usually camera Trigger and Strobe.

1

Bottom Connections

3
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2. Encoder inputs
3. Serial Port
4. Reset switch

2

Typical Configuration

Camera1 Camera2

Trigger
inputs

Strobe 
outputs

4

1. Power connector 24V

A-CAB-GE-X

A-CAB-G3-IO-X

Power

Top Connections



Camera IO Connector
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Pin # Label VICORE Function

1 T- Camera 1 Trigger In– (GND)

2 T+ Camera 1 Trigger In+

3 O- Camera 1 Strobe Out–

4 O+ Camera 1 Strobe Out+ (24V)

5 T- Camera 2 Trigger In– (GND)

6 T+ Camera 2 Trigger In+

7 O- Camera 2 Strobe Out–

8 O+ Camera 2 Strobe Out+ (24V)

This connector provides trigger and strobe connections for two cameras using common 
ground for the camera’s input and common 24V for the camera’s output. 
Two 4-pin connectors are supplied with the VICORE. One connector for each camera.

Part Number Cable Length

A-CAB-G3-IO-0 3 meters

A-CAB-G3-IO-1 5 meters

A-CAB-G3-IO-2 10 meters

The Genie Nano and the Calibir use the same 10-pin connector for IO but with different 
pinout assignments. A 10-pin 10-wire IO cable is available in three lengths.

IO Cables



Genie Nano
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Label VICORE Function Wire Color Genie Nano Pin # Genie Nano Function

T- Trigger – (GND) Brown 3 Input Common

T+ Trigger + Blue 7 GPI2 +  Line 2

O- Strobe – Violet 8 GPO2 +  Line 4

O+ Strobe + (24V) Orange 4 Output Common

VICORE is compatible with the Genie Nano IO design using common ground for the 
camera’s input and common 24V for the camera’s output. Note: iNspect Express 
defines Camera Input 2 as the Trigger and Camera Output 2 as the (optional) Strobe. 
Genie Nano Wiring

Calibir GXM640 and DXM640

Label VICORE Function Wire Color Calibir Pin # Calibir Function

T- Trigger – (GND) Brown 3 Input Common

T+ Trigger + Yellow 5 GPI_P0 +  Line 1

O- Strobe – Green 6 GPO_P0 +  Line 2

O+ Strobe + (24V) Orange 4 Output Common

VICORE is compatible with the Calibir design using common ground for the camera’s 
input and common 24V for the camera’s output. GXM640 and DXM640 both support 
triggering.

Calibir GXM640 & DXM640 Wiring

Calibir 640 GigE
VICORE is compatible with the Calibir design using common ground for the camera’s 
input. Calibir 640 requires a firmware update (January 2020) to support triggering. 

Label VICORE Function Wire Color Calibir Pin # Calibir Function

T- Trigger – (GND) Blue 7 Input Common

T+ Trigger + Orange 4 GPI_P0 +  Line 1

O- Strobe – No connection No output available

O+ Strobe + (24V) No connection No output available

Calibir 640 Wiring



VICORE supports the Z-Trak 3D laser profiler (Sherlock 8 only) the Calibir IR (thermal) 
camera and the Genie Nano series cameras for image acquisition.

The Genie Nano series offers a range of sensor resolutions from 640x480 up to 
5120x5120 pixels in color and monochrome.

The following should be noted when matching your application camera needs to the 
VICORE:
1. Sherlock 8: Cameras can be a mix of different resolutions. Sherlock 8 supports the 

Genie Nano, Calibir and Z-Trak.
2. Sherlock 7: Cameras can be a mix of different resolutions. Sherlock 7 supports the 

Genie Nano and Calibir. The Z-Trak is not supported.
3. iNspect Express: All cameras must be the same resolution (size and color/mono) in 

iNspect Express. iNspect Express supports the Genie Nano and Calibir. The Z-Trak 
is not supported.

Two cables are needed in the setup of each camera. The data cable (A-CAB-GE-X) 
connects the camera’s Ethernet port to one of the VICORE camera ports and provides 
camera power. The I/O cable provides access to the camera’s I/O, supporting trigger 
input and strobe output.

iNspect Express and Sherlock use different software drivers to interface GigE cameras. 
iNspect Express uses a driver called IFC, whereas Sherlock uses a driver called 
Sapera LT. The setups associated with each will be described later in this manual. 
Generally, Sapera offers additional flexibility over IFC, but requires additional steps to 
set up. 

Note: By default, iNspect Express and Sherlock assumes Genie Nano camera Input 2 
(Line 2) is the trigger input and Genie Nano camera Output 2 (Line 4) is the strobe 
output. 

GigE Camera Suport
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Specifications

The following table lists the specifications of the VICORE vision system.

General Specifications

Specification Definition

Platform Processor Quad Core Atom x5-E3940 CPU @ 1.8 GHz

OS Windows 10 IoT 64-bit

Memory Storage 32GB Solid State Flash Drive

Program 4GB DDR3L 1333/1600 MHz non-expandable

Communication Ethernet 2x Gigabit PCIe ports support POE for cameras

1x Gigabit PCIe direct lane for Network connection

PLC 1x 100MBps port for Industrial Ethernet-IP or Profinet devices. 
Cannot be used for cameras or other network support.

Serial 1x RS-232/343/485 DS-9-pin; default parameters 11520 baud, 8 
data stop bits, no parity, 1 stop bit, no flow control

USB 2x USB 3.0 and 2 x USB 2.0

I/O 8 isolated Inputs, 8 isolated Outputs with 16 status LEDs

Encoder 6 inputs: +/-A, +/-B, +/-E and Ground

LED status 3 indicators for Power, Reset and Fault; 3 application defined,
2x per camera: 1 input & 1 output each,
8 Input and 8 Output for general purpose IO

Display HDMI 19-pin HDMI up to 3849x2160 @ 24 Hz or 2560x1600 @ 60 Hz; 
display supports clone, independent, extended modes

Power 20.7 – 31.0 V 25.1 W @ 24 V without cameras, 39 W @ 24 V with 2 cameras.

Recessed Reset button. Use pointed object to push and hold for 
5 seconds.

Cooling Fanless Passive heatsink 

Mechanical Material Machined Aluminum with paint finish

Mounting DIN Rail mount

Size 160 mm x 90 mm x 55 mm

Weight 0.76 KG

Environment Temp 0°C to 40°C Operating  -20°C to 70°C Storage 

Humidity 5 to 95% non-condensing

Certification CE, FCC Class A, RoHS
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Input and Output Connector
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Pin # Type Function

1 Input Input 0 (default trigger for both cameras)

2 Input Input 1

3 Input Input 2

4 Input Input 3

5 Common Common for inputs 0-3

6 Input Input 4  (optional camera 2 separate trigger)

7 Input Input 5

8 Input Input 6

9 Input Input 7 Job Change

10 Common Common for inputs 4-7

11 Output Output 0

12 Output Output 1

13 Output Output 2

14 Output Output 3 or camera 1 strobe output

15 Common Common for outputs 0-3

16 Output Output 4

17 Output Output 5

18 Output Output 6

19 Output Output 7  or camera 2 strobe output

20 Common Common for output 4-7

The VICORE Inputs and Outputs are opto-
isolated and may be wired for sourcing or 
sinking current. The inputs and outputs are 
organized in four groups. Each group has a 
dedicated common (for power or ground) and 
each group can be wired independently. 
Example wiring diagrams are on page 17. 



Inputs Specification
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Parameter Value

Isolation Optical

Maximum Input Voltage 30 Volts

Maximum Input Current 30 mA

Minimum Voltage to Engage Trigger 11.0 V typical

Input Resistance 3.32 kOhm

Electrical Isolation 400 V RMS

Noise Reduction Ferrite bead 120 ohms at 100 MHz

Polarity Bidirectional: can be positive or negative

Typical current at 24V input 8 mA

Switching time ON 20 us typical, direct connection 5 meter cable

Switching time OFF 15 us typical, direct connection 5 meter cable

iNspect uses Input 0 as the trigger to both cameras in Sync mode. In Async mode Input 
0 is the Camera1 trigger and Input 4 is the Camera2 trigger. Sherlock defaults to input 0 
for both cameras but also allows you to select your own input assignments.



Outputs Specification
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Parameter Value

Isolation Optical

Maximum Load Current continuous 170 mA

Maximum Load Current peak Pulsed 300 mA for 100 seconds
Pulsed 400 mA for  seconds
Pulsed 500 mA for 1.9 seconds – duty cycle 
must be 10% or less

Maximum Load Voltage 30 Volts

Output ON resistance 1 ohm minimum 5.5 ohm maximum

Isolation 1500 VAC

Noise reduction Ferrite 2 kOhm at 100 MHz (1 k on signal, 1 k 
on common)

Output capacitance 10 nF

Switching time ON 600 us typical, 2000 us maximum

Switching time OFF 80 us typical, 500 us maximum

iNspect and Sherlock both use Output 3 as the Camera1 strobe and Output 7 as the 
Camera2 strobe. This assignment is not reconfigurable.



Wiring Diagrams
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Each group of 4 inputs can be wired independently.

Each group of 4 outputs can be wired independently.



Encoder Inputs Specification
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Parameter Value

Isolation Not isolated

Maximum data rate 20Mbps

Encoding modes Single-Channel X1, Dual-Channel X1
Single-Channel X2, Dual-Channel X2
Dual-Channel X4 must be 10% or less

Signals A+/A-, B+/B-, Z+/Z- RS-422 / RS-485

Common-Mode Range VCM -7 to +12 V

Differential Threshold VTH Min -200 mV Max +200 mV

Input Resistance 48 kOhm minimum

Input Current +/- 0.2 mA maximum

ESD Protection Contact Discharge +/-8 kV
Air Gap Discharge +/-15 kV

Shaft Encoder Inputs are used for synchronizing to 
moving or rotating equipment.

RS-232 Connector

Pin # Connection

1 No connection

2 RX – input

3 TX – output

4 No connection

5 Ground

6, 7, 8, 9 No Connection

VICORE has one standard serial port for communication with peripheral devices.
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LED Status Indicators
There are 6 LEDs at the top-left corner of the front panel which 
provide system status. Some are also available for program use. 

Label Displayable Colors Status

Red/Green Green – power good
Red – Unit is shut down, or power fault

Reset Red/Green Red – Reset active
Green – user defined

Fault Red/Green Red – Hardware fault: FPGA Not loaded, CPU error, 
Temperature alert, internal voltage fault

Green – application defined

1 Red/Green/Amber Amber blinking – VICORE powering up, continues 
blinking until stopped by starting a software 
application.

Green blinking – iNspect Express heartbeat: 2s 50%
Red/Green/Amber – application defined

2 Red/Green/Amber Green blinking – iNspect Express acquisition:2s 50%
Red/Green/Amber – application defined

3 Red/Green/Amber Red/Green/Amber – application defined

Note: All other LEDs on the VICORE are green only and turn on when a particular input 
or output is active.



VICORE Mechanical Dimensions

Front View
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Side View

All dimensions are in millimeters

Bottom View



Accessing VICORE

Connect a Monitor, Keyboard and Mouse directly to the VICORE to access it “directly” 
like a PC or laptop. Connectors are shown on page 8.

1. Connect a monitor to the HDMI connector. 

2. Connect a keyboard and mouse to any of the 4 USB connectors. 

VICORE is configured to boot to the desktop without requiring a password. This is the 
administrator account. You can change settings to require a password or add additional 
user accounts through Windows setup.

Direct Access

VICORE is already configured at our factory to allow Remote Desktop access. You 
need to configure your PC or laptop to access VICORE. There are a few things you 
need to know about VICORE:

• VICORE default computer name is “VIC-” plus the full 7 digits of the serial number, 
for example: VIC-1234567. 

• VICORE default LAN address is 192.168.0.100 and Subnet mask 255.255.255.0.

• The default account name is “teledyne” and the default password is “teledyne”.

Use the steps below to connect to VICORE using Remote Desktop in Windows 10.
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You can connect a PC or laptop to VICORE using an ethernet cable, to access VICORE 
“remotely” using “Remote Desktop” on your PC or Laptop.

Remote Access

Overview of Remote Access

1. Connect an Ethernet cable to the VICORE LAN connector (#4 on page 8).

2. Connect the other end of the Ethernet cable to your PC or Laptop LAN connector.

3. Configure your PC or Laptop’s LAN Address to be compatible with VICORE (details 
on page 22).

4. Open the Remote Desktop application on your PC or Laptop (details on page 23).

5. Enter the Computer name of your VICORE and the account user name.

6. Click the Connect button. You will be asked for a password.

After several seconds a window will open showing part of the VICORE desktop.



5. Click on “Internet Protocol Version 4 
(TCP/IPv4)”. Scroll down to find it if 
necessary.

6. Click the Properties button.

How To Configure Your LAN Address
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3. Click on Change adapter options.

The exact steps to open your system settings may depend on your Windows 
configuration, account permissions, and network security settings. 

1. In the Windows 10 Start menu, click on the Settings button. 

2. Click on Network & Internet.

4. Right-click on the Ethernet connector 
you will use for connecting to VICORE 
and select “Properties”.

Depending on your account and security, you may 
be asked to confirm changing settings by clicking 
on Yes or No. Or you may be asked to enter an 
Administrator password.



7. Click the bubble beside “Use the 
following IP address:”

8. Enter an address that is compatible 
with VICORE, for example 
192.168.0.101.

9. Click in the field beside “Subnet 
mask.” It should populate 
automatically to show 
255.255.255.0.

10. Click OK to close the IP4 menu. 

11. Click OK to close the Port 
properties menu. You do not have 
to reboot the PC or Laptop for an 
address change.
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How To Open Remote Desktop

2. Click on “Remote Desktop Connection” (not on 
the arrow beside it). 

1. Click the Search button in the taskbar and type “Remote Desktop”.

3. Click the Show Options button.

The remembered Computer name and 
user name (if any) are displayed or as 
shown here no previous connection data.
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4. Enter the Computer name and 
account user name. 

The default Computer name is “VIC-” 
followed by the 7 digits of the 
VICORE serial number. Such as: 
VIC-1234567. The default account 
name is “teledyne”. 

Note: User names are not case 
sensitive.

5. Click the Connect button. You will be 
asked to supply a password. The 
default password is “teledyne”. 

Note: The password is case sensitive.

6. After several seconds the remote desktop window will open showing part of the 
VICORE desktop with the Teledyne logo. You can maximize this window.



Software Applications Interface

VICORE has the 64-bit Windows 10 IoT operating system. VICORE-03 model has 
iNspect Express licensed (Sherlock is not licensed). VICORE-04 model has Sherlock 8, 
Sherlock 7 and iNspect Express licensed for Genie Nano and Calibir. VICORE-H model 
(for Z-Trak) has no software license installed. The Z-Trak includes a Sherlock 8 3D 
license. These applications offer a suite of vision capabilities that satisfy a diverse range 
of automated inspection needs. The following shows where VICORE software is 
installed. Refer to the respective software user manual for more information. Manuals 
provided on the VICORE system drive. C:\IPD Install Files\PDF Manuals

Getting Started

Software Directory Structure 
Software applications are installed in various directories on the VICORE. The following 
table lists the location and association of core programs and data directories referenced 
in this manual.

Note: The directory C:\ProgramData and everything below it is normally hidden as 
required by Microsoft Windows rules. iNspect Express and Sherlock have a Start Menu 
shortcut to the User Files Directory, which includes Programs Images and configuration. 
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Sherlock 8 Program Files and Directories
Sherlock C:\Program Files\Teledyne Dalsa\Sherlock8x64\bin\IpeApp.exe
Sherlock Drivers C:\ProgramData\Teledyne Dalsa\Sherlock8x64\drivers-data
Sherlock Programs C:\ProgramData\Teledyne Dalsa\Sherlock8x64\programs
Emulator Images C:\ProgramData\Teledyne Dalsa\Sherlock8x64\images
Sapera CamExpert C:\Program Files\Teledyne Dalsa\Sapera LT\CamExpert.exe
iDiscoverGenie C:\Program Files\Teledyne Dalsa\Sherlock8x64\bin\iDiscoverGenie.exe
License Manager C:\Program Files\Teledyne Dalsa\Sherlock8x64\bin\IpdLicMgr.exe
Sherlock 7 Program Files and Directories
Sherlock C:\Program Files\Teledyne Dalsa\Sherlockx64\bin\IpeStudio.exe
Sherlock Drivers C:\ProgramData\Teledyne Dalsa\Sherlockx64\Drivers
Sherlock Programs C:\ProgramData\Teledyne Dalsa\Sherlockx64\Programs
Emulator Images C:\ProgramData\Teledyne Dalsa\Sherlockx64\Images
Sapera Acquisition Wizard C:\Program Files\Teledyne Dalsa\Sherlockx64\bin\IpeSaqAcqWiz.exe
Sapera CamExpert C:\Program Files\Teledyne Dalsa\Sapera LT\CamExpert\CamExpert.exe
License Manager C:\Program Files\Teledyne Dalsa\Sherlockx64\bin\IpdLicMgr.exe
iNspect Express Program Files and Directories
Configurator C:\Program Files\Teledyne Dalsa\iNspectExpress x64\iNspectExpressConfig.exe
iNspect Express C:\Program Files\Teledyne Dalsa\iNspectExpress x64\Express.bat
Solution Files C:\ProgramData\Teledyne Dalsa\iNspectExpressVA\Solutions
Emulator Images C:\ProgramData\Teledyne Dalsa\iNspectExpressVA\Images
iDiscoverGenie C:\Program Files\Teledyne Dalsa\iNspectExpress x64\iDiscoverGenie.exe
License Manager C:\Program Files\Teledyne Dalsa\iNspectExpress x64\IdpLicMgr.exe



The License Manager
The software installed on the VICORE is license-protected. The license is applied to the 
unit system number before it ships from the factory. Make sure that the product license 
matches what you ordered before going any further. Open the license manager from the 
“start menu” as follows:

Start ➔Teledyne DALSA Sherlock 8 x64➔License Manager
Start➔Teledyne DALSA Sherlock x64➔License Manager
Start➔Teledyne DALSA iNspect x64➔License Manager 

If the license does not reflect what you 
purchased, consult your Teledyne Imaging 
sales representative. The license is field 
upgradable by entering a new string in the 
“Enter License” box then clicking “Update 
License”. 

Note: QuickBarcode DPM is an optional license 
addition.

This example shows the model -04 with 
Sherlock and iNspect Express both licensed. 
Your system may have only one of these 
licenses (model -03 has only iNspect Express 
licensed). 

“System #11931690309” is the VICORE SSD. 

A Genie Nano camera or Z-Trak Laser Profiler 
would be listed as “Sapera LT Board #######”.
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Note: The license manager requires 
Administrator privileges.

This example shows a Sherlock 8 license 
stored on a connected Z-Trak Laser Profiler. 
“Sapera LT Board” refers to the Z-Trak and in 
this example the serial number is 20000000.

If you purchase the –H model no licensees will 
be installed. Connecting a Z-Trak as indicated 
above will enable the Sherlock 8 software.

Note: iNspect Express does not support a 
license stored on a camera.



The iDiscoverGenie utility is provided for discovering GigE cameras connected to the 
VICORE. Use the iDiscover interface to change the camera IP settings to match the IP 
setting of the camera port. 

• A shortcut to iDiscoverGenie is available on the VICORE desktop.

• Sherlock 8 creates a shortcut to iDiscoverGenie in the Windows start menu:
Start ➔Teledyne DALSA Sherlock 8 x64➔GigE devices network utility

The cameras are listed in the center field.  A red camera icon indicates the camera IP 
Address is not compatible with the NIC port and needs to be corrected. A blue camera 
icon indicates the camera IP Address is compatible with the NIC port.

To change a camera’s IP Address or Subnet Mask:

1. Click on one of the cameras to populate the network configuration on the right. You 
can then modify the camera IP address to match the camera port IP segment at the 
top. The first 3 fields must match the NIC, the last field must be different.

2. Click the “Apply” button to save changes. The camera will reappear configured with 
the new address. A Genie-TS camera will disappear and must be power cycled.

Camera Address
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Select a camera.

Change the 
selected camera’s 
Address and 
Subnet mask.

Click Apply to 
save changes to 
the camera.



1. Select Profinet or Ethernet IP and click 
Apply. The progress bar changes to  show 
the firmware being loaded.

2. Enter an IP Address for the VICORE port 
which is compatible with your PLC or 
machine network. Enter a subnet mask 
that matches your network. 

3. Enter the default gateway if your network 
requires it. Some networks are set to 
ignore the gateway.

4. Enter a device name for the PLC to use 
when addressing the VICORE.

PLC Port Configuration
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The VICORE uses dedicated port for Ethernet-IP or Profinet communication only. This 
port is not configured or controlled under Windows or Sapera networking. The PLC port 
is factory-configured for Ethernet-IP with a static IP address 192.168.10.100.
Note: The IFC driver must be enabled in Sherlock 8 or Sherlock 7 to use the PLC port.
Use the VICORE PLC Configure utility to set up this port for communication. You may 
choose either Profinet or Ethernet-IP as your configuration.

The VICORE PLC Configure utility can be launched from the 
iNspect Express Configurator (page 43) or the Windows Start 
menu:  Start➔VA GenICam X64 Tools➔VICORE PLC Configure

5. Click Apply when finished, then click Close. 
6. If you changed the Device Type (Profinet/Ethernet-IP) the progress bar will show 

the Port configuration being loaded. You will be asked to shut down the VICORE.
7. If you did not change the device type, but you did change other information, you 

should reboot (soft boot) your VICORE to complete the address configuration.
8. You may wish to reopen the Configurator to verify your changes were successful.
Note: iNspect Express and Sherlock 7 automatically select the PLC Port for Ethernet-IP 
or Profient communication. In Sherlock 8 you must create a PLC “hard” communication 
object for the PLC Port. Note: The VICORE LAN port will not support Ethernet-IP or 
Profinet communication.
Note: If you switch between the two setups the PLC may see the VICORE as a new 
device and refuse to connect, even if the name and address are the same.



The first time you use Sherlock 8, you should save the list of attached cameras. 
Sherlock detects the cameras and configures one image workspace accordingly. From 
Sherlock 8 you can launch CamExpert configurator and change the camera settings. 
Sherlock 8 uses the settings stored in the camera, or in camera configuration files. You 
can also use Sherlock instructions to change Gain, Exposure (shutter time) or Strobe 
pulse width programmatically (IO:Camera:write_number).
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1. In Sherlock’s main window, pull down the Options 
menu and select “Configure Drivers”. 

Sherlock always opens with the “default” configuration.

Note: The IFC io driver must be enabled 
for the VICORE IO and the PLC port.

3. All cameras are enabled by default. Clear 
the check boxes beside any cameras you do 
not wish to use. Sherlock 8 will reserve all 
attached cameras that it finds, unless they 
are listed here and unchecked.

4. Click the “Save discovered to active” button. 
This copies the new list of devices over the 
original empty list. 

5. You can click the “Run CamExpert” button to configure camera settings and save a 
configuration file (page 30). Close CamExpert to return to this menu.

6. Click the “Show active config” button to edit the Sapera LT configuration file and point 
to your camera configuration file. (page 31)

2. Click the Run button beside Sapera. 
This opens the GenICam devices menu 
showing a list of all detected cameras.

Sherlock 8 Setup

The configuration is interactive. Changes 
you make are used immediately and 
saved when you close Sherlock.
The Sapera, IFC io, Network and Serial 
drivers are enabled by default. 



GigE cameras store their configuration settings (I/O, shutter speed, white balance) in 
memory (EEPROM). Changes you make to the camera settings are temporary, unless 
saved to the camera memory or to a configuration file. The Sherlock 7 Install Guide and 
Sherlock 8 Tutorial 3 discuss configuring cameras in CamExpert. Tutorial 2 discusses 
using CamExpert X to configure the Z-Trak profiler.

• Sherlock will use the current camera state or load a saved configuration file during 
program initialization.

• iNspect Express overrides these settings and configures the camera according to the 
solution file.

You can change a camera’s parameters and save them to the camera memory and/or 
to a configuration file using the Sapera CamExpert utility. You can configure the camera 
to load either your saved settings or the factory settings from its memory at power up. 
The preferred method is to save your settings to both the camera and a configuration 
file. Sherlock can load a configuration file at startup. If the two cameras are the same, 
you can use one file for both cameras. If different configurations are needed, you can 
create different configuration files for each camera.

The Sapera CamExpert Utility
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All the detected cameras are listed (below). The file begins with a list of the cameras 
and their status equal to True or False. All cameras you unchecked are false. Sherlock 
will not access or reserve the cameras set to “false”. The cameras appear in Sherlock 
in the order they are listed here. You can change the camera order by editing this file.

1. If you created camera configuration files, edit the “configfile=“ to point to your files (a 
full path is required). Note: You can use the same file for multiple cameras if they are 
the same model and the same settings. Or you can create multiple files to load 
different camera settings at startup.

2. If you have color cameras, enter the values for Red, Green and Blue gain values 
form CamExpert. Enter as floating point; for example: 1.0524, 1.843113.

3. Save the Sapera configuration file when finished. (File-Save or Ctrl-S in Notepad).

4. Close the INI file. 

5. Close the GigE Devices window. 

6. Close the Sapera Driver configurator.

Camera order and enable. 
Sherlock 8 uses the Serial Number to identify each camera. 

Path to camera 1 configuration file

Color gain values for camera 1

Color gain values for camera 2

Path to camera 1 configuration file



Configure the VICORE I/O in Sherlock 8
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Using a Supplied File
There are four VICORE configuration files supplied. Edit the IFCDrv.ini file to point to 
one of the four files found in directory: C:\VAGenie\Config

• VICORENoStrobesTrig0&0.txt – Default setting. No Strobe signals enabled to the 
VICORE IO connector, both cameras use VICORE Input 0 for the trigger. 

• VICORENoStrobesTrig0&4.txt – No Strobe signals enabled to the VICORE IO 
connector, Camera 1 uses Input 0 for trigger and Camera 2 uses Input 4 for trigger.

• VICOREStrobe1&2Trig0&0.txt – Camera 1 strobe goes to VICORE Output 3 and 
Camera 2 strobe goes to Output 7. Both cameras use VICORE Input 0 for trigger.

• VICOREStrobe1&2Trig0&4.txt – Camera 1 strobe goes to VICORE Output 3 and 
Camera 2 Strobe goes to Output 7. Camera 1 uses Input 0 for trigger and Camera 
2 uses Input 4 for trigger.

Create a New Configuration File
You can use the “VA GenICam X64 Setup” to create a new configuration file (page 34). 
You can turn the strobe outputs on or off, and you can select which VICORE inputs 
supply triggers to the two cameras. Note: You should disconnect the cameras while 
creating an IO Configuration file.

When you open VA GenICam X64 Setup the default on both Camera ports is: strobe 
outputs disabled, Camera port 1 uses  GPI[0] for trigger and Camera port 2 uses 
GPI[4] for trigger.

A configuration file is not required but it is recommended. By default Input 0 triggers 
both cameras and strobe outputs are disabled. A Configuration file allows you to 
customize the IO settings.
1. In the Hardware Devices configuration 

menu, click the Run button beside IFC 
io driver. This opens a file in Notepad.

2. Edit the line “CONFIG=“ to point to a 
valid VICORE IO Configuration file.

3. Save the Ipeifcdrv.ini file and exit 
notepad.

4. Close the Hardware Devices 
menu to return to Sherlock 8.



Triggers and strobes are enabled in the camera, in the VICORE Configuration file, and 
in the Sherlock Application. Use this page to check that you have made all the 
necessary changes.

Enabling Trigger and Strobe in Sherlock 8
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16. In the Program Window, open the Properties for the acquire instruction. Change the 
timeout if necessary (for a large image or a long trigger interval) .

1. Launch Sherlock 8 and then launch CamExpert (page 30). 
2. Select the IO Controls in the left most pane in CamExpert.
3. Change the Trigger Mode to On. Change the Trigger Source to Line 2 (Input 2). 
4. Use the Line Selector to select Line 4 (Output 2).
5. Change the mode to one of the Pulse output options for a camera strobe output.
6. Click the Save button in the toolbar or use the File menu to select Save.
7. In the popup, change the two “default” fields to identify the new camera settings, 

such as “TrigIn2” and “StrobeOut2”.
8. Click Save. The default location is C:\Program Files\Sapera\CamFiles\User
If the cameras are the same model and use the same settings, you can use one file for 
both cameras. Or you can create different files with different settings.

9. Open the Sapera LT Configuration (last step on page 29) and edit it to point to the 
configuration file you just saved (page 31). Do this for both cameras.

10.Save and Close the Sapera LT Configuration file.
11.Open the IFC Configuration file (page 32). 
12.Change the “CONFIG=“ to point to a VICORE configuration file (page 32). The 

default file is Strobes disabled and Trigger 0 for both cameras.
13.Save this file and close.
14. In Sherlock 8 open the System Objects window and select Image Sources. 
15.Select a Camera and open the camera object properties. Change the trigger to 

External. Repeat for the second camera.
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3. Click on Port 0 in the upper pane. 

4. Click the Trigger tab at the bottom of 
the pane. 

5. Click on the field beside “Trigger 
Source” to activate the pull-down.

6. Select your trigger source from one of 
the VICORE inputs.

IFC_EXT_AUTO_TRIG setting allows 
iNspect Express to select the correct 
trigger input in Synchronous and 
Asynchronous modes. Sherlock does 
not have a defined Synchronous and 
Asynchronous mode.  

GenICam X64 Setup
1. Disconnect the cameras so you do not get information you will 

have to delete later.

2. Open the GenICamSetup X64 Tool from the start menu :
Start ➔ VA GeniCam X64 Tools ➔ VA GenICam X64 Setup

Note: The IPD Version utility only works in 32-bit environments.

When you open VA GenICam X64 Setup the default on both camera ports is: Strobe 
outputs disabled, Camera port 1 uses VICORE input IN0 for trigger and Camera port 2 
uses VICORE IN4 for trigger. The 2 camera ports are configured separately.

7. Click on the Strobe tab at the bottom 
of the pane. 

8. Click in the right column beside Strobe 
Output Enable to activate the pull-down.

9. Select IFC_ENABLE to allow the 
camera’s strobe signal to pass to the 
VICORE outputs.

Camera1 (Port0) strobe goes to VICORE 
output 0 and Camera2 (Port1) strobe 
goes to output 4. This cannot be altered.

3

4

5

7

8
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10.Now click on port 1 in the upper pane. You are asked to save the changes to port 
0. Answer yes.

11.You will be asked to give a name to your port configuration.

12.You are then given the 
option to apply the 
changes to all ports. Check 
the boxes beside each port 
if you want both ports the 
same. 

13.Click OK.

2. Save the file using a name you will recognize. 

3. You will point to this saved file using Sherlock. 
The default location is C:\VAGeniex64\Config

14. If you want different settings on Port 1, click on Port 1 and repeat steps 4 through 
13.

Save Your Configuration
1. Use the File menu to select “Generate Portable 

Config File”. This creates a single detailed file for all 
ports and their settings.



Follow these steps to configure the VICORE system to run Sherlock 7:
1. Connect cameras as shown in the typical installation (page 9).
2. Run the License Manager and verify a valid license is installed (page 26).
3. Run the iDiscover utility (page 27) or the Sapera Network Configuration Tool to 

detect and configure the addresses of all cameras connected to the system.
4. Run the Sapera CamExpert utility if you want to change settings in any of the 

cameras such as trigger, exposure, strobe or white balance (page 37).
5. Run the Sapera Acquisition Wizard to verify all attached GigE cameras are shown 

as expected and click the “save” button (page 38) to save the configuration file 
(SaperaLTDrv.ini).

6. Launch Sherlock 7 using the shortcut on the desktop (Sherlock GUI shown below). 
7. Go to the Options menu and select “Acquisition”. In the “Configure Driver Loading” 

section enable “Sapera LT” for the GigE cameras and enable “Ifc” for the VICORE 
IO and the PLC port. Close Sherlock 7.

8. Use the Start menu shortcut for Sherlock’s User Data Directory. Open the “Drivers” 
directory. Edit the “IfcDrv.ini” file to point to a valid configuration file (page 40). A full 
path is required. Note: Sherlock 7 may fail to run if you enable “Ifc” but do not point 
to a valid configuration file!

9. Open Sherlock 7 again. Driver changes only take effect when Sherlock opens.
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VICORE IO in Sherlock 7
In the default configuration both cameras use Input 0 for Trigger and the strobe 
outputs are disabled. You can change this configuration (see page 40).

Sherlock 7 Setup



GigE cameras store their configuration settings (I/O, shutter speed, white balance) in 
memory (EEPROM). Changes you make to the camera settings are temporary, unless 
saved to the camera memory or to a configuration file. The Sherlock 7 Install Guide and 
Sherlock 8 Tutorial 3 discuss configuring cameras in CamExpert.

• Sherlock will use the current camera state or load a saved configuration file during 
program initialization.

• iNspect Express overrides these settings and configures the camera according to the 
solution file.

You can change a camera’s parameters and save them to the camera memory and/or 
to a configuration file using the Sapera CamExpert utility. You can configure the camera 
to load either your saved settings or the factory settings from its memory at power up. 
The preferred method is to save your settings to both the camera and a configuration 
file. Sherlock can load a configuration file at startup. If the two cameras are the same, 
you can use one file for both cameras. If different configurations are needed, you can 
create different configuration files for each camera.

The Sapera CamExpert Utility
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The Sapera Acquisition Wizard detects all available cameras and creates a file 
“SaperaLTDrv.ini” that identifies them in Sherlock 7. Note: If the saved configuration 
does not match the number of cameras, the Sapera LT driver will not load and Sherlock 
will not run saved programs. Instead, Sherlock will open a new investigation (job) file. 

The Sherlock application uses the settings stored in the camera, or in camera 
configuration files. You can use Sherlock instructions to change Gain, Exposure (shutter 
time) or Strobe pulse width (IO:Camera:SetNumberFeature) programmatically.

1. When you launch the wizard you may see a warning that the current configuration 
cannot be loaded. This means the current cameras do not match the last saved list.

2. All cameras connected to the VICORE should be listed in the device window. 
3. Only the first camera is enabled by default. If you have more than camera, you must 

enable it in this dialog. 
4. Enable using configuration files and brows to the file location.
5. Expand the “Device Settings” and enter color gain values from CamExpert.
6. Click the “save” button to store the configuration in the SaperaLTDrv.ini file.

The Sapera Acquisition Wizard
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Sapera Acquisition Wizard creates a text file SaperaLtDrv.ini (below) Sherlock 7 will 
load this file on startup. The full path to configuration files appears beside “ConfigFile”. 
You can enter the Color Gain values in Sapera Acquisition Wizard or in this file. You can 
also change the camera order by editing this file. “Server0” is the first camera and 
appears twice in the definition. “Server1” is the second camera. Do not open the Wizard 
and resave a configuration file after you have edited this file.
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Server0 is the first camera or “camera0” in 
Sherlock 7.

Sherlock 7 uses the DeviceName to identify 
each camera.

Server1 is the second camera or “camera1” in 
Sherlock 7.

Path to camera 0 configuration file

Color gain values for camera 0

Path to camera 1 configuration file

Color gain values for camera 1



Use a Supplied Configuration File
There are four VICORE configuration files in directory: C:\VAGenieX64\Config
• VICORENoStrobesTrig0&0.txt – Default setting. No Strobe signals enabled to the 

VICORE IO connector. Both cameras use VICORE Input 0 for the trigger.
• VICORENoStrobesTrig0&4.txt – No Strobe signals enabled to the VICORE IO 

connector. Camera 1 uses input 0 for trigger and Camera 2 uses Input 4 for trigger.
• VICOREStrobe1&2Trig0&0.txt – Camera 1 strobe goes to VICORE Output 3 and 

Camera 2 strobe goes to Output 7. Both cameras use VICORE Input 0 for trigger.
• VICOREStrobe1&2Trig0&4.txt – Camera 1 strobe goes to VICORE Output 3 and 

Camera 2 Strobe goes to Output 7. Camera 1 uses Input 0 for trigger and Camera 2 
uses Input 4 for trigger.

Configure the VICORE IO in Sherlock 7
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Create a New Configuration File
You can use “GenICam X64 Setup” to create a new configuration file (page 34). You 
can turn the strobe outputs on or off, and you can select what VICORE inputs supply 
triggers to the two cameras. Note: You should disconnect the cameras while creating 
an IO Configuration file. 

When you open VA GenICam X64 Setup the default on both Camera ports is: strobe 
outputs disabled, Camera port 1 uses  GPI[0] for trigger and Camera port 2 uses 
GPI[4] for trigger.

To Change the default:
1. Use the Start menu to open the User Files directory. Open the Drivers folder.
2. Right-click on the file IfcDrv.ini and select Open. This launches notepad.
3. Edit the line “CONFIG=“ to point to a valid VICORE IO Configuration file.

The IFC Driver requires a configuration file to spell out the IO functions of the VICORE. 
Note: Enabling the driver without specifying a configuration file may cause Sherlock 7 to 
not run. 

The default setup selects file VICORENoStrrobesTrig0&0.txt. Both cameras use Input 0 
for a trigger and strobe outputs are disabled.



Triggers and strobes are enabled in the camera, in the VICORE Configuration file, and 
in the Sherlock Application. Use this page to check that you have made all the 
necessary changes.

Enabling Trigger and Strobe in Sherlock 7
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6. Launch Sapera Acquisition Wizard (page 38).
7. Enable both cameras. Configuration Files. Use the Browse button to find the 

configuration file you just saved. 
8. Click Save and then click Exit.
9. Use the Start menu shortcut to open the User Data Directory.
10.Open the “Drivers” directory and edit the file “ifcdrv.ini”.
11.Change the “CONFIG=“ to point to a VICORE configuration file (page 40). The 

default file is Strobes disabled and Trigger 0 for both cameras.
12.Save this file and close.
13.Launch Sherlock 7. Double-click in the image to open the properties for the Image 

Window.
14.Click the “External Camera Trigger” checkbox and change the Triggered Acquisition 

Timeout value. It is in milliseconds; 1000 is one second.

1. Launch CamExpert (page 37). Select a camera.
2. Select the IO Controls in the left most pane.
3. Change the Trigger Mode to On. Change the Trigger Source to Input 2 or Line 2. 
4. Use the Line Selector to select Line 4 (Output 2).
5. Change the mode to one of the Pulse output options.
6. Click the Save button in the toolbar or use the File menu to select Save.
7. In the popup, change the two “default” fields to identify the new camera settings, 

such as “TrigIn2” and “StrobeOut2”.
8. Click Save. The default location is C:\Program Files\Sapera\CamFiles\User
If the cameras are the same model and use the same settings, you can use one file for 
both cameras. Or you can create different files with different settings.



Follow these steps to configure the system to run iNspect Express:
1. Connect one or two cameras as shown in the typical installation (page 9).
2. Run the License Manager and verify a valid license is installed (page 26).
3. Open the iNspect Express Configurator utility and configure preferences; Select 

“GigE” in the camera menu (page 43).
4. Click on the iDiscover Genie button to detect and configure cameras connected to 

the system (page 44).
5. Save Camera set (select which connected cameras you want to use).
6. Close iDiscover and launch iNspect Express (run panel shown below).

VICORE IO in iNspect Express
iNspect Express automatically recognizes the VICORE. You do not need to add a 
configuration file for the VICORE I/O. You cannot override the iNspect Express 
assignments.
• In Synchronous mode VICORE Input 0 is the trigger to both cameras. 
• In Asynchronous mode Input 0 is the trigger for Camera1 and Input 4 is the trigger for 

Camera2. 
• Strobes are disabled by default in iNspect Express. If you enable the strobes, 

Camera1 strobe is VICORE Output 3 and Camera2 strobe is Output 7.
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iNspect Express Setup



This program is a front-end configuration tool for iNspect Express and for the Emulator. 

1. Launch the configurator from desktop icon, or from the Start menu.
2. Select the Language and custom features for your application. These features are 

peculiar to iNspect Express and are detailed in the software user’s manual.
3. To use the Emulator select “Emulator” and launch iNspect Express.
4. To use cameras select GigE cameras. 
5. Launch iDiscover (page 44) to configure camera addresses. 
6. Select “Enable Async Acquisition” if asynchronous mode is required.
7. Launch iNspect Express.

The iNspect Express Configurator

Launch 
iDiscover 
Genie

Launch 
iNspect 
Express
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Launch 
VICORE 
PLC Port 
Configurator



The iDiscoverGenie utility is provided for discovering GigE cameras connected to the 
VICORE. Use the iDiscover interface to change the camera IP settings to match the IP 
setting of the camera port. A shortcut to iDiscover is available on the VICORE desktop. 

1. Click on one of the cameras to populate the network configuration on the right. You 
can then modify the camera IP address to match the camera port IP segment at the 
top. Note: Conflicting IP addresses will be designated by a red camera icon in the 
detected camera menu.

2. Click the “Apply” button to save changes. The camera will reappear configured at the 
new address. Note: A Genie-TS camera will disappear and must be rebooted to 
apply the new address.

3. Select which cameras to use in your iNspect Express configuration by clicking and 
moving them to the left panel using the arrow buttons. You can change the camera 
order in iNspect Express by using the up/down arrow buttons on the left control bar. 

4. Save the corrected camera list. Then Close iDiscover Genie.

The iDiscover Genie Utility

Click to save the 
list of cameras.

Click to close iDiscover Genie and return to the Configurator.
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Add a selected 
camera or all 
cameras to the 
list.

Change the 
order of 
cameras.

Delete a selected 
camera from the 
list.

Change the 
selected camera’s 
Address and 
Subnet mask.

Click to save 
changes to the 
camera.



Triggers and strobes are controlled in the Sensor Setup panel in the iNspect Express 
application. The first time you start iNspect Express (after installation) the default is:

• Trigger inputs disabled, using internal timer to acquire cameras. 
• Strobe outputs disabled.
• If you change the trigger and strobe settings, they are saved in your “Solution” or 

job file. And the new settings are used as the default when you create new job files

Enabling Trigger and Strobe in iNspect Express
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6. Use the checkbox under Inspection Trigger Delay to enable delay. Use the sliders to 
adjust the Offset (amount of delay) between the External Trigger signal and the 
camera image.

1. Launch iNspect Express Configurator.
2. If the two cameras operate independently enable Async mode (asynchronous). If the 

two cameras operate together (synchronized) do not enable Async mode.
3. Launch iNspect Express. 
4. Click the Sensor button. Use the drop-list in the top right corner to select a camera.
5. Use the first row of bubbles (radio buttons) under Trigger Source to select a trigger:

• Internal Timer: the slider below the button 
controls camera images.

• External Trigger: a signal from the I/O 
connector controls camera images.

• Software Trigger: a command instruction 
controls camera images.

7. Use the checkbox under Strobe Output Pulse to 
enable strobe output. Use the two sliders to 
adjust the strobe delay and duration. 

8. If you enabled Async mode, the triggers and strobes for both cameras are 
adjustable independently. If you are using synchronized cameras, only the strobe 
settings are adjustable independently. Note: You must enable Async Mode before
you begin. A synchronous Solution setup cannot be converted to an asynchronous 
Solution setup once you have begun.



Job Switching Using Inputs
Solutions (job files) can be loaded on demand using the GPI1 & GPI2 inputs. A PLC, or 
other hardware controlling device, sets a HIGH signal on the “job change” line (GPI1) 
and sends a series of pulses on the “job select” line (GPI2) equal to the solution #. For 
example, solution 12 = 12 pulses.
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The pulse train requires a 1 millisecond (1 ms) setup and hold time between any edge 
transition. When a solution switch is detected, VICORE will abort the current inspection 
(if running) and switch immediately.

To use the inputs for job switching, select the “Job Change” and “Job Select” functions 
in the Input control setup panel as shown.

Note: Job switching is also supported through the software user interface and scripting.

1 ms Minimum 1 ms Minimum



The VICORE uses the Windows 10 IoT operating system, which supports a Unified 
Write Filter (UWF) that provides the ability to write-protect a run-time image. By 
redirecting all write requests to an overlay disk or RAM partition, UWF allows the run-
time image to maintain the appearance of a writeable run-time image. The UWF 
prevents accidental file corruption when accessing the system or when the system 
suddenly loses power.

The default state of the UWF is disabled allowing full access to files on the unit. When 
you have completed development of your application, we recommended enabling the 
filter to prevent accidental data corruption. When the filter is enabled, only writes to the 
C:\ProgramData\Teledyne DALSA and C:\Program Files\Teledyne DALSA\Sherlock 
directories will be allowed, all other system and program directories will be blocked. 

The UWF is located in the C:\IPD Install Files directory. The utility has a GUI (graphic 
user interface) for displaying status and setting the filter. Changes take effect on the 
next system reboot.

Note: If you have run the filter and not yet rebooted, it is still showing the current status 
from when you booted, not what you have set for the next reboot!

Windows Unified Write Filter

A “registration form” with an “activation code” was shipped with your unit. Registration is 
free. You should register with Acronis to obtain a key to unlock this software. Once 
unlocked, you can create your own backup files on removable media (a USB thumb 
drive) or a network resource.  We suggest you make your own full backup on a 
bootable thumb drive. You can use one thumb drive for booting to Acronis and a second 
thumb drive for storing the image.

Create a Backup
1. Use Windows to make a bootable thumb drive. 

2. Use Acronis tools to create a “bootable backup” (you must register first) which 
deposits the Acronis restore executable onto the drive. 

3. Run Acronis to create a full backup on the thumb drive. 

Acronis® True Image Software
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Additional Software Applications
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5. A loader menu is displayed. Press 1 on your keyboard for the Recover option.

Restore the Factory Image 
A backup image was created using the Acronis® True Image Software before your unit 
was shipped. Restoring the factory image will all files and configuration changes. Back 
up your files before restoring the factory image.

1. Reboot the VICORE system. 

2. When the Teledyne logo is displayed tap the Delete key continuously to enter BIOS.

3. Use the right arrow key to select the “Save and Exit” tab.

4. Use the down arrow key to select “Acronis loader” under the “Boot Override” options 
and press the Enter key.

6. Press the Y key to confirm the restore. 
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